ST155 - Mail Merging E-Mails to the College Letterhead Using Word 2010

June 2014

Book online at: rhul.ac.uk/it/training
or scan QR code
Self-Study packs also available
ST155 Mail Merging E-mails to the College Letterhead using Microsoft Word 2010

Contents

1 Session Introduction .................................................. 1
   1.1 Folder Required .................................................. 1
   1.2 The Mail Merge Process .......................................... 1
   1.3 Copying the Mail Merging E-mails to the College Letterhead Folder .......... 2
   1.4 Opening Outlook .................................................. 3

2 Creating a Mail Merge to E-mails ........................................ 4
   2.1 Opening the Data Source .......................................... 4
      2.1.2 Modifying the Data Source .................................. 4
   2.2 Starting Microsoft Word .......................................... 5
   2.3 Opening the Main Document ...................................... 5
      2.3.1 Entering Your details into the Letterhead ........................ 6
      2.3.2 Saving the Letterhead ....................................... 7
      2.3.3 Adding content to the Letterhead document ................... 7
   2.4 Beginning the Mail Merge ........................................ 9
      2.4.1 Displaying the Mail Merge Task Pane ........................ 9
      2.4.2 Beginning the Merge Process ................................ 9
      2.4.3 Using an Existing Data Source ............................... 10
      2.4.4 Entering the Merge Fields into the Main Document ............ 11
      2.4.5 Creating the Merged E-mails ................................ 13
   2.5 Producing a Mail Merge using Selective Text ...................... 15
      2.5.1 Re-opening the College Letterhead with content document ......... 15
      2.5.2 Displaying the Mail Merge Task Pane ........................ 16
      2.5.3 Beginning the Merge Process ................................ 16
      2.5.4 Accessing an Existing Data Source ............................ 16
      2.5.5 Entering the Merge Fields into the Letterhead Document ........ 17
      2.5.6 Using the Selective Text Facility ............................. 18
      2.5.7 Setting up the Selective Text Facility ........................ 18
      2.5.8 Completing the Merge Process ................................ 19
      2.5.9 Closing the Documents ....................................... 20

3 Word’s Standard Field Names .......................................... 21

4 Accessing the (R:) & (Y:) Drives from Own PC etc. ................... 22

These Session Notes are available in alternative formats on request.
For further information please contact Chris Horton
in Computer Centre Room 108
(01784 41 4025, c.horton@rhul.ac.uk)

© Royal Holloway and Bedford New College 2014. All Rights Reserved
1 Session Introduction

In this session you will learn how to use Word's Mail Merge facility to produce personalised e-mails that display on the College Letterhead.

You will also learn how to use Mail Merge's Selective Merge facility, which uses a condition that you have set up to enable one of two different lines of text to be inserted into a mail merged e-mail.

1.1 Folder Required

The folder you will require for this session is:

<table>
<thead>
<tr>
<th>R:\CC\ST155 Mail Merging E-mails to the College Letterhead</th>
</tr>
</thead>
<tbody>
<tr>
<td>This contains the following files:</td>
</tr>
<tr>
<td>College Letterhead for Mail Merge March 2014.docx</td>
</tr>
<tr>
<td>E-mail letter.docx</td>
</tr>
<tr>
<td>E-mail Data Doc.xlsx</td>
</tr>
</tbody>
</table>

1.2 The Mail Merge Process

Mail Merging is the process of combining a standard document, termed the Main Document, with a data file, termed the Data Source (e.g. an Excel spreadsheet), to produce a third document, the Form Document, which can be produced as either a printed or e-mailed document.

This process is frequently used to produce mailshots, where a standard, but personalised, letter/e-mail is sent to a number of different people.
1.3 Copying the Mail Merging E-mails to the College Letterhead Folder

We will begin the session by using Windows Explorer to copy a folder containing the files we will be using from the (R:) drive on to our (Y:) drive.  

**Note:** see page 22 for details of setting up the (R:) drive if you do not already have it mapped on your PC etc.

**To open Windows Explorer:**

(a) Click on the **Start** button at the left of the Task bar to display the Start Menu.

(b) Click on **Computer** (formerly **My Computer**) to the right of the **Start** menu if available.

**OR**

i) Click on the **Start** button to display the Start Menu.

ii) Click on **Programs** or **All Programs**.

iii) Click on **Accessories**.

iv) Click on **Windows Explorer**.

**Note:** an alternative method is to press the **[Windows]** key at the right of the keyboard and with it still depressed press **[E]** on the keyboard.

**To copy the folder from the (R:) drive to your (Y:) drive:**

(a) If necessary scroll down in the **left-hand panel** to display the list of available drives.

(b) Click on the (R:) drive to display its contents in the right-hand panel.

(c) In the **right-hand panel** double-click on the CC folder, which is where the session’s folder is located.

(d) In the **right-hand** panel locate the **ST155 Mail Merging E-mails to the College Letterhead** folder, and then right-click on it to obtain a short cut menu.

(e) We want to copy this folder, so click on **Copy**.

(f) In the **left-hand** pane, scroll down to locate your (Y:) drive then right-click on the drive to obtain a short cut menu.

(g) Select **Paste** to paste the folder into your (Y:) drive ready for use.

(h) Close Windows Explorer by clicking on its Close button ✗.
1.4 Opening Outlook
As we will be working with e-mails we should first ensure that Outlook is running. To do this on an Open-Access PC:

(a) Click on the Start button to open the Start Menu.
(b) Click on All Programs.
(c) Click on Current Applications.
(d) Click on Microsoft Office 2010 or Office 2010
(e) Click on .
(f) When the Microsoft Outlook 2010 Startup dialogue box displays click on [Next].
(g) When the E-mail Accounts dialogue box displays click on [Next].
(h) When the Auto Account Setup dialogue box displays let it auto-load your details, then click on [Next].
(i) Once the Microsoft Outlook Username and Password dialogue box displays enter the Password you use to log on to your office PC.
(j) Click on [OK] to close the Microsoft Outlook dialogue box.
(k) Then click on [Finish]. Outlook will display after the completion of its setting up.
2 Creating a Mail Merge to E-mails

We will begin by examining how Mail Merge can be used to produce individualised e-mails. To do this we will use a Main Document, which in this case is a version of the College Letterhead, along with an Excel based Data Source.

We will start by modifying the Excel based Data Source so that it includes our own e-mail address. This will enable us, in this case, to know that the mail merged e-mails have been produced.

2.1 Opening the Data Source

We now need to open the Excel Data Source in order to add our e-mail address. To do this on an Open-Access PC:

(a) Click on the Start button at the left of the Task Bar to display the Start Menu.
(b) Click on Microsoft Excel 2010.
(c) Click on the File tab at the left of the Ribbon.
(d) Click on Open to display the Open dialogue box.
(e) If necessary scroll down in the left-hand panel to display the list of available drives.
(f) Click on the (Y:) drive in the list to select the drive and display its contents in the right-hand panel.
(g) In the right-hand panel locate the ST155 Mail Merging E-mails to the College Letterhead folder, and then double-click on it to display its contents.
(h) Click on the file name you want to open, which in this case is: E-mail Data Doc.xlsx
(i) Click on [Open] to open the spreadsheet.

2.1.2 Modifying the Data Source

We can now modify the Data Source to include our own e-mail address:

(a) Click in cell A4 and then enter your first name.
(b) Click in cell B4 and then enter your family name.
(c) Click in cell C4 and enter your College e-mail address.
(d) When finished click on cell A1 to reduce the possibility of a blank row being included in the Data Source.
(e) Save the changes by clicking on the Save button in the Quick Access Toolbar at the top left of the window.
(f) That completes the work we need to do on our Data Source, so close Excel by clicking on its Close button ⌠.
Note: It is suggested that:
- If using Excel to create your Data Source you use only one Worksheet per Excel file (Workbook), and that you delete all remaining unused Worksheets. This will make it easier to select the Data Source within the Mail Merge process.
- Wherever possible use Word’s ‘expected’ column headings, as highlighted on page 21.

2.2 Starting Microsoft Word
We will now start up Word 2010 in order to use the Mail Merge facility and produce our personalised e-mails.

To do this from an Open Access PC Lab:
(a) Click on the **Start** button at the left of the Task bar to display the Start Menu.
(b) Click on ![Microsoft Word 2010](image)

2.3 Opening the Main Document
For the purpose of this session we will use a Main Document that has already been produced, and included within the **ST155 Mail Merging E-mails to the College Letterhead** folder.

In this case it is a version of the re-branded College Letterhead that can be used for mail merging to e-mails.

To open this Main Document:
(a) Click on the **File** tab at the left of the **Ribbon**.
(b) Click on **Open** to display the **Open** dialogue box.
(c) If necessary scroll down in the **left-hand panel** to display the list of available drives.
(d) Click on the (Y:) drive in the list to select the drive and display its contents in the right-hand panel.
(e) In the **right-hand panel** locate the **ST155 Mail Merging E-mails to the College Letterhead** folder, and then double-click on it to display its contents.
(f) In the **right-hand panel** locate the **College Letterhead for Mail Merge March 2014.docx** file and then select it by clicking on it.
(g) Click on **[Open]** to open the document.
2.3.1 Entering Your details into the Letterhead

To begin using the Mail Merge to E-mail Letterhead you need to personalise it by entering your details into the appropriate areas.

Once you have done that you can save it for future use.

To enter your details:

(a) If the yellow band displays below the Ribbon stating that the file might be unsafe click on Enable Editing.

(b) Double-click on the orange Name heading at the right of the Letterhead to select it. Then overtype this with your name.

(c) Double-click on the Qualifications heading below your name. Then overtype this with your qualifications. OR if you do not want this to appear press the [Backspace] button on the keyboard twice to remove the text and close up the line.

(d) Click and drag across the Job Title heading to select it. Then overtype this with your job title.

(e) Double-click on the Department heading below your job title. Then overtype this with your Department’s name.

(f) Click and drag across the xxxxxx at the right of the phone number below your Department’s name. Then overtype this with your phone extension number, remembering to include the 41, 44, or 67 prefix as appropriate.

(g) Click and drag across the xxxxxx at the left of the e-mail address below your phone number. Then overtype this with the name part of your e-mail address.

(h) The Recipient Name and Recipient Address headings at the left of the Letterhead are not needed in this case. To Remove them:
   i) Click and drag across the Recipient Name and three Recipient Address lines of text to select them.
   ii) Press the [Delete] key on the keyboard.

(i) Finally double click on the Date ‘holding title’. Then overtype it with an appropriate date in a format of your choice.
2.3.2 Saving the Letterhead

Once you have entered your details into the Letterhead document it is worth saving it before adding any content.

This will enable the Letterhead, complete with your personalised details, to be reused in the future for other e-mails, without the need to delete any content.

To save the personalised Letterhead document:
   (a) Click on the **Save** button in the Quick Access Toolbar at the top left of the window.

2.3.3 Adding content to the Letterhead document

To reduce the amount of typing we need to do in this session, we will now open another document that contains some suitable content for our e-mail.

This is another document that is included in the **ST155 Mail Merging E-mails to the College Letterhead** folder.

We will then copy the text from this document into the Letterhead document ready for creating our mail merge to e-mails.

To open this document:
   (a) Click on the **File** tab at the left of the **Ribbon**.
   (b) Click on **Open** to display the **Open** dialogue box.
   (c) If the **ST155 Mail Merging E-mails to the College Letterhead** folder is not displaying in the right-hand panel:
      i) If necessary scroll down in the **left-hand panel** to display the list of available drives.
      ii) Click on the (Y:) drive in the list to select the drive and display its contents in the right-hand panel.
      iii) In the **right-hand** panel locate the **ST155 Mail Merging E-mails to the College Letterhead** folder, and then double-click on it to display its contents.
   (d) In the **right-hand** panel locate the **E-mail Letter.docx** file and then select it by clicking on it.
   (e) Click on **Open** to open the document.
   (f) If the yellow band displays below the **Ribbon** stating that the file might be unsafe click on **Enable Editing**.
To copy the text from this document to the Letterhead document:

(a) Click and drag across the document’s text, **including** the top blank line, to select it.

(b) Ensure that the **Home** tab at the left of the **Ribbon** is selected.

(c) Copy the text by clicking on the **Copy** button in the **Clipboard** group at the left of the **Ribbon**.

(d) Return to the letterheader document by clicking on the left-hand **Word** button on the Task bar at the bottom of the screen.

To paste the text into the Letterhead document:

(a) Click and drag across the text **Replace this text with your own** (below the date at the left of the page) to select it.

(b) Now replace the selected text:
   i) Ensure that the **Home** tab at the left of the **Ribbon** is selected.
   ii) Click on the **Paste** button in the **Clipboard** group at the left of the **Ribbon**.

We will now save the modified Letterhead document with a new filename so that the original updated version is preserved:

(a) Click on the **File** tab at the left of the **Ribbon**.

(b) Click on **Save As** to display the **Save As** dialogue box.

(c) If the **ST155 Mail Merging E-mails to the College Letterhead** folder is **not** displaying in the right-hand panel:
   i) If necessary scroll down in the **left-hand panel** to display the list of available drives.
   ii) Click on the **(Y:)** drive in the list to select the drive and display its contents in the right-hand panel.
   iii) In the **right-hand** panel locate the **ST155 Mail Merging E-mails to the College Letterhead** folder, and then double-click on it to display its contents.

(d) In the **File name:** panel modify the existing file name to one that suitably identifies this is the modified version, for example by changing it to:

**College Letterhead with content.docx**

(e) Click on **[Save]** to save the Letterhead document with its new file name.
2.4  Beginning the Mail Merge
Now that the Main Document has been set up we can produce the personalised mail merged e-mails.

2.4.1  Displaying the Mail Merge Task Pane
One way of accessing the Mail Merge facility within Word 2010 is via the Mail Merge Task Pane. This can be very useful because it guides you step-by-step through the process. To display this:
(a) Click on the Mailings tab towards the centre of the Ribbon.
(b) Click on Start Mail Merge in the Start Mail Merge group towards the left of the Ribbon.
(c) Select Step by Step Mail Merge Wizard at the bottom of the list that displays.
The Mail Merge Task Pane displays on the right-hand side of the screen.

2.4.2  Beginning the Merge Process
To begin the actual Mail Merge process you need to specify what type of document you are going to produce, which in this case is an e-mail message. Therefore to do this:
(a) Ensure that the heading Step 1 of 6 is displayed towards the bottom of the Task Pane. If it is not click on the Previous: link below the ‘Step’ heading enough times to display it.
(b) Under the Select document type heading at the top of the Task Pane click on the E-mail messages option so that it displays a check mark.
(c) Under the Step 1 of 6 heading towards the bottom of the Task Pane click on the Next: Starting document link.
(d) Click on the Use the current document option under the Select starting document heading so that it displays a check mark.
(e) Click on the Next: Select recipients link towards the bottom of the Task Pane.
2.4.3 Using an Existing Data Source

We now need to select the Data Source that we wish to use.

In this case we will be using the Excel spreadsheet we modified earlier:

(a) At the top of the Task Pane click on the **Use an existing list** option under the **Select recipients** heading so that it displays a check mark.

(b) Click on the **Browse** link located below the **Use an existing list** heading at the centre of the Task Pane to display the **Select Data Source** dialogue box.

(c) If necessary scroll down in the **left-hand panel** to display the list of available drives.

(d) Click on the (Y:) drive in the list to select the drive and display its contents in the right-hand panel.

(e) In the right-hand panel locate the **ST155 Mail Merging E-mails to the College Letterhead** folder, and then double-click on it to display its contents.

(f) In the right-hand panel click on the file name you want to open, in this case: **E-mail Data Doc.xlsx**

(g) Click on **[Open]**.

(h) The **Select Table** dialogue box displays prompting you to select which table (or worksheet) you wish to use from the file that you have just selected.

(i) In this case there is only one table (worksheet) to select from, so click on **[OK]** to accept this and close the dialogue box.

(j) The **Mail Merge Recipients** dialogue box displays.

This enables us to select which records in the current data source are to be included in the Merge operation.

(k) As, in this case, we wish to include all of the records, we need to ensure that the check box to the left of the **Last Name** field for each row contains a tick mark.

(l) An easy way to do this is to ensure that the check box between the **Data Source** and **Last Name** headings contains a tick mark (circled in illustration on right).

(m) When you have finished, click on **[OK]** to close the dialogue box.
2.4.4 Entering the Merge Fields into the Main Document

We now need to enter the Merge Fields into our Main Document to show Word where the individual data fields (e.g. first name) from our Data Source should appear in our e-mails.

Word provides four options for entering Merge Fields into a document or e-mail:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address block</td>
<td>Enables a complete address (compiled from the Address 1, Address 2 etc Merge Fields) to be inserted as a single Merge Field. This can be useful, for example, when needing to include a company address at the top of a business letter/e-mail.</td>
</tr>
<tr>
<td>Greeting line</td>
<td>Enables a salutation to be easily inserted, e.g. Dear John, or Dear Sir or Madam. As this option can substitute Dear Sir or Madam (or other text) should the name not be in the Data Source, the situation where just Dear (and no name) is avoided.</td>
</tr>
<tr>
<td>Electronic postage</td>
<td>Enables an electronic postage stamp to be printed on envelopes. This requires an add-in to be installed to deal with the stamp’s payment.</td>
</tr>
<tr>
<td>More items</td>
<td>Enables individual Merge Fields to be inserted from a dialogue box. The Merge Fields are picked up from, and given the same name as, the headings you include within the Data Source.</td>
</tr>
</tbody>
</table>

In this case we will use the Greeting line option to insert the student’s first name at the top of the e-mail, and the More items option to insert their year into the text.

To insert the Greeting line Merge Field:

(a) Click on the Next: Write your e-mail message link towards the bottom of the Task Pane.

(b) Position the insertion point where you want the first Merge Field to be inserted.

(c) In this case we will enter the recipient’s first name as the salutation, so position the insertion point so that it is one line below the Date on the left-hand side.

(d) Click on the Greeting line link at the centre of the Task Pane to display the Insert Greeting Line dialogue box.

(e) Click on the down-arrow to the right of the left-most text box below the Greeting line format: heading and select the option you wish to use.

(f) In this case we will select the Dear option.

**Note:** If you wish to use an option that is not included, simply overtype the content of the text box with the text you wish to use, remembering to include a space at the end of it.

(g) Click on the down-arrow to the right of the centre text box below the Greeting line format: heading and select the format for the name that you wish to use.
In this case we will enter the option to display the applicant’s first name by selecting **Joshua**, which is the 9th option down.

Similarly, click on the down-arrow to the right of the right-most text box below the **Greeting line format:** heading and select the punctuation option you wish to include at the end of the greeting.

In this case we will select (none), so that no punctuation is included.

Finally, you can specify how you want the salutation to display when Word cannot find the name. Setting this prevents the salutation displaying just (e.g.) Dear when the name is missing from the Data Source.

To do this click on the down-arrow to the right of the text box below the **Greeting line for invalid recipient names:** heading.

Then select the option you wish to use, which in this case is the **Dear Sir or Madam,** option.

Note: To use an option that is not included in the list, simply overtype the content of the text box with the text you wish to use.

If you want you can view how the salutation will appear in the mail merged letters by clicking on the left and right arrows below the **Preview** heading.

When you have finished click on **[OK]** to close the dialogue box.

If necessary, enter a blank line between the salutation and next line of text by pressing **[Enter]** on the keyboard.

**To insert the Year Merge Field:**

(a) We will now use the **Insert Merge Field** dialogue box to insert the student’s year of study into the text.

(b) To begin, locate the sentence: **Congratulations on progressing to your year.**

   Then click between the text **your** and **year,** ensuring that the included spaces are either side of the insertion point.

(c) Click on the **More items**, option at the centre of the Task Pane to display the **Insert Merge Field** dialogue box.

(d) Ensure that the **Database Fields** option under the **Insert:** panel contains a check mark.

(e) Under the **Fields:** heading, click on the field heading that you want to insert into your document, which in this case is **Year.**

(f) Click on **[Insert]** to insert the Merge Field.
When you have finished click on [Close] to close the dialogue box.

The modified Letterhead now contains both the text for our e-mails and the two Merge Fields to enable them to be personalised. If it is likely that you will need to reuse this Letterhead in the future it could be useful to save it. This will prevent it having to be recreated in the future.

In this case we will save it. Therefore click on the Save button in the Quick Access Toolbar at the top left of the screen.

2.4.5 Creating the Merged E-mails

We can now complete the merge process, and so obtain the personalised messages to all of the records in our data set:

(a) Click on the Next: Preview your e-mail messages link towards the bottom of the Task Pane.

(b) Preview the individual messages by clicking on the Next or Previous buttons under the Preview your e-mail messages heading at the top of the Task Pane.

Notice that both the salutation and year changes for each e-mail.

(c) When you have finished click on the Next: Complete the merge link towards the bottom of the Task Pane.

(d) Your Mail Merged messages are now ready to send. To do this:

i) Click on the Electronic Mail link under the Merge heading on the Task Pane to display the Merge to E-mail dialogue box.

ii) Ensure that the To: panel displays the correct Merge Field for the e-mail address, which in this case is e-mail_Address (taken from the e-mail Address column heading in Excel).

iii) In the Subject line: panel enter the text you wish to appear in the e-mail's Subject panel. In this case enter, for example, Welcome Back to Royal Holloway

iv) Ensure that the Mail format: panel displays HTML, as this is the most appropriate option to use.
v) Finally, if you wish you can select which messages are to be sent by modifying the **Send records** options.
   
   In this case we will select **All**.

vi) When you are ready click on **[OK]** to begin the send process.

   **Note: Doing this actually SENDS the e-mails – there is no warning dialogue box!**

(e) When you have finished close the document by clicking on the **File** tab and selecting **Close**. If Word asks whether you wish to save the document click on **[Save]** or **[Don’t Save]** as appropriate.

(f) When you have finished close Word

(g) If you now view Outlook you should see the mail merged e-mail in your Inbox.
2.5 Producing a Mail Merge using Selective Text

Another feature within Mail Merge is the facility to insert one of two different lines of text into the mail merged e-mail depending on whether or not a condition you specify is satisfied.

To demonstrate this we will produce a merged document that includes text that indicates how the student should pay their fees, either as one payment for a poor or unknown status, or termly for a good status.

To enable this the Data Document that we are using, E-mail Listing.xlsx, includes a Status field that indicates good, unknown or poor.

To show how this works we will produce another merged document based on the modified Letterhead document that we have just been working on.

As we have this document complete with the Merge Codes, this will give experience of working with a document that already contains these.

Before beginning ensure that Word is open.
If it is not, to open it from an Open Access PC Lab:
(a) Click on the Start button at the left of the Task bar to display the Start Menu.

(b) Click on Microsoft Word 2010.

2.5.1 Re-opening the College Letterhead with content document

To begin, we need to re-open the Letterhead document we have been working on:
(a) Click on the File tab at the left of the Ribbon.

(b) Click on Open to display the Open dialogue box.

(c) If the ST155 Mail Merging E-mails to the College Letterhead folder is not displaying in the right-hand panel:
   i) If necessary scroll down in the left-hand panel to display the list of available drives.
   ii) Click on the (Y:) drive in the list to select the drive and display its contents in the right-hand panel.
   iii) In the right-hand panel locate the ST155 Mail Merging E-mails to the College Letterhead folder, and then double-click on it to display its contents.

(d) In the right-hand panel locate the College Letterhead with content.docx file and then select it by clicking on it.

(e) Click on [Open] to open the document.

(f) When the Microsoft Word dialogue box displays stating that Opening the document will run an SQL command click on [No] to stop the command from running and close the dialogue box.

**Note:** This dialogue box displays because the Letterhead document we opened has been already linked to a Data Source.
2.5.2 Displaying the Mail Merge Task Pane

One way of accessing the Mail Merge facility within Word 2010 is via the **Mail Merge** Task Pane. This can be very useful because it guides you step-by-step through the process. To display this:

(a) Click on the **Mailings** tab towards the centre of the **Ribbon**.

(b) Click on **Start Mail Merge** in the **Start Mail Merge** group towards the left of the **Ribbon**.

(c) Select **Step by Step Mail Merge Wizard** at the bottom of the list that displays.

The **Mail Merge** Task Pane displays on the right-hand side of the screen.

2.5.3 Beginning the Merge Process

To begin the actual Mail Merge process you need to specify what type of document you are going to produce. Therefore to do this:

(a) Ensure that the heading **Step 1 of 6** is displayed towards the bottom of the Task Pane. If it is not click on the **Previous** link below the ‘**Step**’ heading enough times to display it.

(b) Under the **Select document type** heading at the top of the Task Pane click on the **E-mail messages** option so that it displays a check mark.

(c) Under the **Step 1 of 6** heading towards the bottom of the Task Pane click on the **Next: Starting document** link.

(d) Click on the **Use the current document** option under the **Select starting document** heading so that it displays a check mark.

(e) Click on the **Next: Select recipients** link towards the bottom of the Task Pane.

2.5.4 Accessing an Existing Data Source

In this case we will use the Excel spreadsheet we previously added our details to as the **Data Source**.

Therefore we now need to specify its location and filename:

(a) At the top of the Task Pane click on the **Use an existing list** option under the **Select recipients** heading so that it displays a check mark.

(b) Click on the **Browse** link located below the **Use an existing list** heading at the centre of the Task Pane to display the **Select Data Source** dialogue box.

(c) If necessary scroll down in the **left-hand panel** to display the list of available drives.

(d) Click on the (Y:) drive in the list to select the drive and display its contents in the right-hand panel.
(e) In the right-hand panel locate the ST155 Mail Merging E-mails to the College Letterhead folder, and then double-click on it to display its contents.

(f) Click on the file name you want to open, in this case: **E-mail Data Doc.xlsx**

(g) Click on [Open].

(h) The **Select Table** dialogue box displays prompting you to select which table (or worksheet) you wish to use from the file that you have just selected.

(i) In this case there is only one table (worksheet) to select from, so click on [OK] to accept this and close the dialogue box.

(j) The **Mail Merge Recipients** dialogue box displays. This enables us to select which records in the current data source are to be included in the Merge operation.

(k) As, in this case, we wish to include all of the records, we need to ensure that the check box to the left of the **Last Name** field for each row contains a tick mark.

(l) An easy way to do this is to ensure that the check box between the **Data Source** and **Last Name** headings contains a tick mark (circled in illustration on right).

(m) When you have finished, click on [OK] to close the dialogue box.

### 2.5.5 Entering the Merge Fields into the Letterhead Document

You would normally now need to enter the merge codes into your Main Document.

However, in this case we do not need to do this because we are using a Main Document that has them already entered.
2.5.6 Using the Selective Text Facility

We will now use the Selective Text facility to include whether the student must pay their fees at the end of September or at the beginning of each term.

To begin doing this we will add a partial sentence to the e-mail text. The Selective Text will then be added to this. To do this:

(a) Click at the end of the sentence that finishes: to seeing you.
(b) Press [Enter] on the keyboard twice to create a new line.
(c) Enter the text for this partial sentence:
   Please remember that your fees need to be paid by
(d) Press the [Spacebar] on the keyboard to add a space at the end of the text.
(e) Save the change by clicking on the Save button in the Quick Access Toolbar at the top left of the window.

2.5.7 Setting up the Selective Text Facility

We can now set up the Selective Text facility to enter the different text depending on the student’s status:

(a) Begin by displaying the Mail Merge Ribbon by click on the Mailings tab at the centre of the Ribbon.
(b) Now position the insertion point where you want the selective text to appear. In this case click at the end of the line of text you have just entered.
(c) We now need to set up the rule to insert the appropriate payment time:
   i) Click on the Rules button towards the centre of the Ribbon in the Write and Insert Fields group.
   ii) From the list that displays select If...Then...Else... to display the Insert Word Field: IF dialogue box.
(d) Click on the down-arrow in the Field name: panel and select the field to which you wish this operation to apply. In this case select Status.
(e) Then click on the down-arrow in the **Comparison**: panel and select the comparison criteria you wish to apply, which in this case is: **Equal to**.

(f) Click within the **Compare to**: panel to obtain an insertion point.

Then enter the criteria which will result in your first text item being inserted into your document. In this case enter **good** as we want the text to apply to all students with a Status of good.

(g) Click within the **Insert this text**: panel to obtain an insertion point, and then enter the text you wish to display for this text item. In this case enter:

```
the beginning of each term.
```

**Note:** This is the text that will be displayed when your **Compare to:** criteria is **true** i.e. has good in the Excel spreadsheet's Status field.

(h) Now click within the **Otherwise inset this text:** panel to obtain an insertion point.

Then enter the text you wish to display for the second text item, which in this case is:

```
the end of September.
```

**Note:** This is the text that will be displayed when your **Compare to:** criteria is **not** true i.e. does not have good (in this case it is poor or unknown) in the Excel spreadsheet’s Status field.

(i) Click on **OK** to close the **Insert Word Field: IF** dialogue box and return to your main document.

### 2.5.8 Completing the Merge Process

We can now complete the merge process. To do this:

(a) Continue the merge operation by clicking on **Next: Write your e-mail message** link towards the bottom of the Task Pane.

(b) Click on the **Next: Preview your e-mail messages** link towards the bottom of the Task Pane.

(c) Preview the individual messages by clicking on the Next or Previous buttons under the **Preview your e-mail messages** heading at the top of the Task Pane.

As you do this notice the salutation, year and text stating when the fees need to be paid for each e-mail.

(d) When you have finished click on the **Next: Complete the merge** link towards the bottom of the Task Pane.

(e) Your Mail Merged messages are now ready to send. To do this:

(i) Click on the **Electronic Mail** link under the **Merge** heading on the Task Pane to display the **Merge to E-mail** dialogue box.
ii) Ensure that the To: panel displays the correct Merge Field for the e-mail address, which in this case is **e-mail_Address** (taken from the e-mail Address column heading in Excel).

iii) In the Subject line: panel enter the text you wish to appear in the e-mail’s Subject panel. In this case enter, for example, **Welcome Back to Royal Holloway 2**

iv) Ensure that the Mail format: panel displays **HTML**, as this is the most appropriate option to use.

v) Finally, if you wish you can select which messages are to be sent by modifying the **Send records** options.

   In this case we will select **All**.

vi) When you are ready click on [OK] to begin the send process.

   **Note:** Doing this actually SENDS the e-mails – there is no warning dialogue box!

### 2.5.9 Closing the Documents

That has completed our work on this particular mail merge operation, and so we will now close the documents. To do this:

(a) Close this Letterhead Document by clicking on its Close button 

   If Word asks whether you wish to save the document click on **Don’t Save**.
### 3 Word’s Standard Field Names

When creating a Data Source, e.g. Excel spreadsheet, for use in Mail Merge you are advised to select the headings (Field Code names) that you use from the following list.

This is especially useful when using the Address Block and Greeting Line facilities because the headings below are the ones that Word ‘expects’ you to use. Therefore, by using these you avoid the situation where data is not incorporated into the merged output because Word does not recognise the heading(s) used.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
</tr>
<tr>
<td>Suffix</td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td></td>
</tr>
<tr>
<td>Address 1</td>
<td></td>
</tr>
<tr>
<td>Address 2</td>
<td></td>
</tr>
<tr>
<td>Address 3</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Postal Code</td>
<td></td>
</tr>
<tr>
<td>Country or Region</td>
<td></td>
</tr>
<tr>
<td>Unique Identifier</td>
<td></td>
</tr>
<tr>
<td>Courtesy Title</td>
<td></td>
</tr>
<tr>
<td>Middle Name</td>
<td></td>
</tr>
<tr>
<td>Nickname</td>
<td></td>
</tr>
<tr>
<td>Job Title</td>
<td></td>
</tr>
<tr>
<td>Department</td>
<td></td>
</tr>
<tr>
<td>Business Phone</td>
<td></td>
</tr>
<tr>
<td>Business Fax</td>
<td></td>
</tr>
<tr>
<td>Home Phone</td>
<td></td>
</tr>
<tr>
<td>Home Fax</td>
<td></td>
</tr>
<tr>
<td>E-mail Address</td>
<td></td>
</tr>
<tr>
<td>Web Page</td>
<td></td>
</tr>
<tr>
<td>Spouse/Partner Courtesy Title</td>
<td></td>
</tr>
<tr>
<td>Spouse/Partner First Name</td>
<td></td>
</tr>
<tr>
<td>Spouse/Partner Middle Name</td>
<td></td>
</tr>
<tr>
<td>Spouse/Partner Last Name</td>
<td></td>
</tr>
<tr>
<td>Spouse/Partner Nickname</td>
<td></td>
</tr>
<tr>
<td>Phonetic Guide for First Name</td>
<td></td>
</tr>
<tr>
<td>Phonetic Guide for Last Name</td>
<td></td>
</tr>
</tbody>
</table>
4 Accessing the (R:) & (Y:) Drives from Own PC etc.

In order to access the files required to complete many of the IT Training exercises you need to access a shared drive, referred to as the (R:) drive in the notes. These instructions give details on how to connect to this drive, for example from your home, along with details on how you can also set up access your (Y:) drive.

**Note:** If using a Mac, instructions on setting up Campus Anywhere (VPN) can be found at: [http://www.rhul.ac.uk/IT/CampusAnywhere/](http://www.rhul.ac.uk/IT/CampusAnywhere/)

Instructions on mapping to the (R:) drive and (Y:) drive can be found at:

[http://www.rhul.ac.uk/it/faq/itfaqs/mac/mapnetworkdrive.aspx](http://www.rhul.ac.uk/it/faq/itfaqs/mac/mapnetworkdrive.aspx)

(a) If working on Campus ensure that you are connected to CampusNet.

OR

If working off Campus ensure that you are connected to the Internet and that you have connected to Campus Anywhere (VPN).

**Note:** To obtain instructions on how to set up Campus Anywhere (VPN) visit: [http://www.rhul.ac.uk/IT/CampusAnywhere](http://www.rhul.ac.uk/IT/CampusAnywhere)

### Accessing the (R:) Drive

**Important:** If your PC etc. already has an (R:) drive you will need to select a different letter in the following instructions.

(b) Begin by displaying **Windows Explorer**. To do this:

i) Click on the Start button at the bottom left of the screen to open the **Start** Menu.

ii) Click on **Computer** to the right of the **Start** menu.

OR

Press the **Windows** key at the right of the keyboard and with it still depressed press **[E]** on the keyboard.

(c) With **Windows Explorer** open click on **Tools**.

(d) Select **Map Network Drive** to open the **Map Network Drive** dialogue box.

(e) Click on the drop-down arrow to the right of the **Drive:** panel and select **R:** (or any letter of your choice if that already has an entry, and so already allocated).

(f) In the **Folder:** panel enter the mapping for the (R:) which is:

    `\\ourdata.rhul.ac.uk\teaching\PCLabs`

(g) Ensure that the **Reconnect at logon** box displays a tick mark. If it does not, click within it so that it displays one.

(h) Click on **[Finish]** to complete the setting up. You should now be able to see the (R:) drive containing the IT Training files.

### Accessing your (Y:) Drive

You can also access your (Y:) drive using the same method, but taking note of the following:

(a) If your PC already has a (Y:) drive you will need to select a different letter in step (e).

(b) In step (f) the path that you must enter is: `\\mydata.rhul.ac.uk\home`

**Note:** When accessing these drives you may be prompted for your username and password. If this occurs you must prefix your username with cc\ For example, if your username is zhaa666 then you must enter cc\zhaa666.